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RZ/V2L, RZ/V2H 
Release Note for RZ/V Multi-OS Package V2.0.0 
Introduction 
This software package provides user with easy way to establish multi-OS (i.e., CIP Linux running on 
Cortex®-A55 and FreeRTOS running on Cortex-M33 and/or Cortex-R8) environment and sample program 
showing how to implement Inter-Processor Communication between those CPU cores. 

This package consists of RZ/V Flexible Software Package (hereinafter referred to as RZ/V FSP) and Multi-
OS Feature Package for RZ/V Verified Linux Package (hereinafter referred to as RZ/V VLP).  

Note: Cortex-R8 is available on RZ/V2H only. 

Here are brief descriptions of each component of RZ/V Multi-OS Package: 

 RZ/V FSP
The software package consisting of production ready peripheral drivers, FreeRTOS and portable
middleware stacks and the best in-case HAL drivers with low memory footprint.

 OpenAMP
The framework including the software components needed for Asymmetric Multiprocessing (AMP)
systems such as Inter-Processor Communication.

Target Device 
RZ/V2L, RZ/V2H 
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1. Specifications 
Table 1-1 lists the on-chip peripheral modules to be used in this application. 

Table 1-1. /Peripheral module to be used 

Peripheral module Usage 
Message Handling Unit (MHU) Configures Inter-Processor Interrupt. 
Serial Communications Interface with FIFO (SCIFA) Performs standard serial communications sending 

and receiving console messages. 
Interrupt controller (INTC) Configures interrupt settings; the processor will 

receive interrupts during buffered serial 
communications, and in the MHU module when 
Inter-Processor Interrupt is fired. 

General Purpose Input Output (GPIO) Configures I/O lines used by serial communications. 
General Timer (GTM) Configures the tick for FreeRTOS. 
 

1.1 Reference boards setup 
For RZ/V2L, please refer to SMARC EVK of RZ/V2L Linux Start-up Guide. Also, for RZ/V2H, please see 
RZ/V2H Evaluation Board Kit (Secure Type) Hardware Manual. 

 

2. Verified Operation Conditions 
Table 2-1. Verified Operating Conditions 

Item Contents 
Microprocessor used RZ/V2L, RZ/V2H 
Integrated Development Environment e2 studio 2024-04 
Toolchain GNU Arm Embedded 12.2.Rel1 
 
 

3. Sample Program Setup 
3.1 RZ/V2L Flexible Software Package Setup 
Please refer to Getting Started with RZ/V Flexible Software Package. 

 

3.2 OpenAMP related stuff Integration for RZ/V2L 
This section describes how to integrate OpenAMP related stuff to RZ/V Verified Linux Package [5.10-CIP] 
(hereinafter referred to as VLP). For details, please refer to SMARC EVK of RZ/V2L Linux Start-up Guide 
(r01us0617ej0101-rz-v(Linux Start-up Guide RZV2L.pdf) included in VLP. 
 
1. Install the package needed for building BSP. 
 
$ sudo apt-get update 
$ sudo apt-get install gawk wget git-core diffstat unzip texinfo gcc-multilib 
build-essential chrpath socat cpio python python3 python3-pip python3-pexpect 
xz-utils debianutils iputils-ping libsdl1.2-dev xterm p7zip-full libyaml-dev 
libssl-dev bmap-tools 
 

2. Configure your Git. 
 
$ git config --global user.email "you@example.com" 
$ git config --global user.name "Your Name" 
 

 

https://www.renesas.com/document/apn/rzv-getting-started-flexible-software-package
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3. Create a working directory at your home directory and extract VLP/V there. 
 
$ mkdir ~/rzv_vlp_<pkg ver>  
$ cd ~/rzv_vlp_<pkg ver> 
$ cp ../<pkg download dir>/*.zip . 
$ unzip RTK0EF0045Z0024AZJ-<pkg ver>.zip 
$ tar zxvf ./RTK0EF0045Z0024AZJ-<pkg ver>/rzv_vlp_<pkg ver>.tar.gz 
 

4. Download Multi-OS Package (r01an7254ej0200-rzv-multi-os-pkg.zip) to working directory and run the 
commands stated below: 

 
$ unzip r01an7254ej0200-rzv-multi-os-pkg.zip 
$ tar zxvf r01an7254ej0200-rzv-multi-os-pkg/meta-rz-features_multi-
os_v2.0.0.tar.gz 
 

5. Initialize Build Environment 
 
$ TEMPLATECONF=$PWD/meta-renesas/meta-rzv2l/docs/template/conf/ source 
poky/oe-init-build-env build 
 

6. Add the layers. The steps add the settings to bblayers.conf. 
 
$ bitbake-layers add-layer ../meta-rz-features/meta-rz-multi-os/meta-rzv2l 
 

 
7.  Start a build by invoking the commands for building VLP. Building an image might take up to a few hours 

depending on the user’s host system performance. 
 
$ MACHINE=smarc-rzv2l bitbake core-image-<target> 
 
Here, the allowable values for “target” in the command are as follows: 

• minimal 
• bsp 
• weston 

 
 

3.3 OpenAMP related stuff Integration for RZ/V2H 
This section describes how to integrate OpenAMP related stuff to RZ/V2H AI Software Development Kit 
(hereinafter referred to as SDK). 

1. Install the package needed for building BSP. 
 
$ sudo apt-get update 
$ sudo apt-get install gawk wget git-core diffstat unzip texinfo gcc-multilib 
build-essential chrpath socat cpio python python3 python3-pip python3-pexpect 
xz-utils debianutils iputils-ping libsdl1.2-dev xterm p7zip-full libyaml-dev 
libssl-dev bmap-tools 
 

2. Configure your Git. 
 
$ git config --global user.email "you@example.com" 
$ git config --global user.name "Your Name" 
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3. Create a working directory at your home directory and extract AI SDK Source Code there. 
 
$ mkdir ~/rzv2h_ai_sdk_<pkg_ver> 
$ cd ~/rzv2h_ai_sdk_<pkg_ver> 
$ cp <AI SDK download dir>/<AI SDK pkg>_linux-src.zip . 
$ unzip <AI SDK download dir>/<pkg ver>_linux-src.zip 
$ tar zxvf <AI SDK pkg>_linux-src/rzv2h_ai-sdk_yocto_recipe_<pkg ver>.tar.gz 
 

4. Download Multi-OS Package (r01an7254ej0200-rzv-multi-os-pkg.zip) to working directory and run the 
commands stated below: 

 
$ cd ~/rzv2h_ai_sdk_<pkg_ver> 
$ unzip r01an7254ej0200-rzv-multi-os-pkg.zip 
$ tar zxvf r01an7254ej0200-rzv-multi-os-pkg/meta-rz-features_multi-
os_v2.0.0.tar.gz 
 

5. Initialize Build Environment 
 
$ TEMPLATECONF=$PWD/meta-renesas/meta-rzv2h/docs/template/conf/ source 
poky/oe-init-build-env build 
 

6. Add the layers. The steps add the settings to bblayers.conf. 
 
$ bitbake-layers add-layer ../meta-rz-features/meta-rz-multi-os/meta-rzv2h 
 

 
7.  Start a build by invoking the commands for building VLP. Building an image might take up to a few hours 

depending on the user’s host system performance. 
 
$ MACHINE=rzv2h-evk-ver1 bitbake core-image-<target> 
 
Here, the allowable values for “target” in the command are as follows: 

• minimal 
• bsp 
• weston 

 
 

3.4 Note for Integration 
On RZ/V Linux, the peripherals which are NOT used enter Module Standby Mode after Linux kernel is 
booted up. That means the peripherals used on CM33 side might NOT become worked implicitly. To avoid 
this situation, we prepare for the patch shown below: 

• 0003-clk-renesas-rzv2l-Set-SCIF2-OSTM2.patch for RZ/V2L 
• 0003-Set-OSTM-for-MCPU-and-RCPU.patch for RZ/V2H 
 
This patch prevents SCIF and GTM(OSTM) used in the rpmsg sample program from entering Module 
Standby Mode. If you have any other peripherals which should NOT enter Module Standby Mode, please 
apply the modification in red to the patch as shown below: 
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drivers/clk/renesas/r9a07g044-cpg.c | 2 ++ 
 1 file changed, 2 insertions(+) 
 
diff --git a/drivers/clk/renesas/r9a07g044-cpg.c 
b/drivers/clk/renesas/r9a07g044-cpg.c 
index e27caa075af7..9e904d2e8180 100644 
--- a/drivers/clk/renesas/r9a07g044-cpg.c 
+++ b/drivers/clk/renesas/r9a07g044-cpg.c 
@@ -449,6 +449,9 @@ static const unsigned int r9a07g044_crit_mod_clks[] 
__initconst = { 
        MOD_CLK_BASE + R9A07G044_IA55_PCLK, 
        MOD_CLK_BASE + R9A07G044_IA55_CLK, 
        MOD_CLK_BASE + R9A07G044_DMAC_ACLK, 
+        MOD_CLK_BASE + R9A07G044_SCIF2_CLK_PCK, 
+        MOD_CLK_BASE + R9A07G044_OSTM2_PCLK, 
+        MOD_CLK_BASE + R9A07G044_xxxx, 
 }; 
 

The line number should be revised in accordance with the number of lines you added. 

With respect to the allowable value for xxxx above, please refer to the source code below:  

• RZ/V2L 
https://github.com/renesas-rz/rz_linux-
cip/blob/c45e3a8129dd0ee36c51079e95962b2f85472e51/drivers/clk/renesas/r9a07g044-cpg.c#L204-
L384 

 
• RZ/V2H 

https://github.com/renesas-rz/rz_linux-
cip/blob/397f22ac9c748f4635c3e9b032dcd45e58908011/drivers/clk/renesas/r9a09g057-cpg.c#L328-
L795 

 
 

3.5 Deployment of RZ/V2L VLP 
With respect to the deployment of Linux kernel, device tree and root filesystem for RZ/V2L, please refer to 
SMARC EVK of RZ/V2L Linux Start-up Guide. 

 

3.6 Deployment of RZ/V2H AI SDK 
With respect to the deployment of Linux kernel, device tree and root filesystem for RZ/V2H, please refer to 
https://renesas-rz.github.io/rzv_ai_sdk/3.00/. 

 

4. Sample Program Invocation on RZ/V2L SMARC EVK 
4.1 Hardware setup 
1. Connect J-Link to RZ/V2L SMARC EVK. For details, please refer to Getting Started with RZ/V Flexible 

Software Package. 
2. Connect Pmod USBUART to the Pmod 1 of SMARC Carrier Board as shown below for securing the 

console for the program running on CM33. 
 

https://github.com/renesas-rz/rz_linux-cip/blob/c45e3a8129dd0ee36c51079e95962b2f85472e51/drivers/clk/renesas/r9a07g044-cpg.c#L204-L384
https://github.com/renesas-rz/rz_linux-cip/blob/c45e3a8129dd0ee36c51079e95962b2f85472e51/drivers/clk/renesas/r9a07g044-cpg.c#L204-L384
https://github.com/renesas-rz/rz_linux-cip/blob/c45e3a8129dd0ee36c51079e95962b2f85472e51/drivers/clk/renesas/r9a07g044-cpg.c#L204-L384
https://github.com/renesas-rz/rz_linux-cip/blob/397f22ac9c748f4635c3e9b032dcd45e58908011/drivers/clk/renesas/r9a09g057-cpg.c#L328-L795
https://github.com/renesas-rz/rz_linux-cip/blob/397f22ac9c748f4635c3e9b032dcd45e58908011/drivers/clk/renesas/r9a09g057-cpg.c#L328-L795
https://github.com/renesas-rz/rz_linux-cip/blob/397f22ac9c748f4635c3e9b032dcd45e58908011/drivers/clk/renesas/r9a09g057-cpg.c#L328-L795
https://renesas-rz.github.io/rzv_ai_sdk/3.00/
https://www.renesas.com/document/apn/rzv-getting-started-flexible-software-package
https://www.renesas.com/document/apn/rzv-getting-started-flexible-software-package
https://store.digilentinc.com/pmod-usbuart-usb-to-uart-interface/
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Figure 4-1.   Connection between RZ/V2L SMARC EVK and Pmod USBUART 
 

4.2 CM33 Sample Program Setup 
Please carry out the following procedures for setting up demo program running on CM33. 

1. Extract r01an7254ej0200-rzv-multi-os-pkg.zip on your development PC. 
2. Extract rzv2l_cm33_rpmsg_demo.zip included in r01an7254ej0200-rzv-multi-os-pkg.zip. 
3. Open e2 studio 2024-04 and click File > Import. 
4. Double-click General and select Existing Projects into Workspace as shown in Figure 4-2: 
 

 

Figure 4-2.   Import sample project (1) 

 
5. Input the path to the folder rzv2l_cm33_rpmsg_demo, press Enter key and click Finish button. 
 

 

Figure 4-3.   Import sample project (2) 
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6. (Optional) By default RPMsg channel 0 is configured to be used on CM33. If you would like to use 
channel 1, open the property of MainTask#0 on FSP Smart Configurator, specify 1 for Thread Context, 
and push Generate Project Content button. If Generate Project Content pop-up is shown, click 
Proceed to reflect the change to the source code. 

 

 

Figure 4-3.   RPMsg channel setting 

 
7. Build the project from Choose Project > Build Project. 
8. If the build is successfully completed, the following files should be generated in Debug and/or Release 

folder in accordance with the active Build Configuration. 
• rzv2l_cm33_rpmsg_demo.elf 
• rzv2l_cm33_rpmsg_demo_non_secure_code.bin 
• rzv2l_cm33_rpmsg_demo_non_secure_vector.bin 
• rzv2l_cm33_rpmsg_demo_secure_code.bin 
• rzv2l_cm33_rpmsg_demo_secure_vector.bin 

 
 

4.3 CM33 Sample Program Invocation 
4.3.1 CM33 Sample Program Invocation with Segger J-Link 
You need to follow the following steps to invocate CM33 sample program with Segger J-Link. 

1. Choose rzv2l_cm33_rpmsg_demo Debug_Flat or rzv2l_cm33_rpmsg_demo Release_Flat from  
the drop-down list indicated by a red arrow in Figure 4-4. 

 

 

Figure 4-4.   Select of Debug Configuration 
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2. Click the debug button indicated by a red arrow in Figure 4-5. 
 

 

Figure 4-5.   Debug Function Launch 

 
If “Confirmation Perspective Switch” window below appears, please press “Switch” to go ahead. 

 

Figure 4-6.   Confirmation window to open the Debug perspective 

 
3. When the debug perspective is opened, Program Counter (PC) should be located at the top of 

Warm_Reset_S function. Then, you need to press the button indicated by a red arrow in Figure 4-7. 
 

 

Figure 4-7.   How to start to debug sample program (1) 
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4. The program should stop at the top of main function. Thus, please click the same button as the previous 
step. 

 

 

Figure 4-8.   How to start to debug sample program (2) 

 
5. Now that CM33 sample program has been started, the following message is shown on the console 

connected to Pmod USBUART: 
 
Successfully probed IPI device 
Successfully open uio device: 42F00000.rsctbl. 
Successfully added memory device 42F00000.rsctbl. 
Successfully open uio device: 43000000.vring-ctl0. 
Successfully added memory device 43000000.vring-ctl0. 
Successfully open uio device: 43200000.vring-shm0. 
Successfully added memory device 43200000.vring-shm0. 
Initialize remoteproc successfully. 
creating remoteproc virtio 
initializing rpmsg vdev 
 
CM33 program is waiting for the establishment of rpmsg channel between CM33 and CA55. 

 
4.3.2 CM33 Sample Program Invocation with u-boot 
You can invoke CM33 sample program from u-boot by following the procedure described below: 

1. Copy the binary files generated at 8 of section 4.2 to microSD card. 
2. Insert the microSD card into CN10 of SMARC carrier board. 
3. Turn on SMARC EVK by pressing reset button (i.e., SW14) 
4. You should now see the following message in the console connected to CN14 of SMARC carrier board: 
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U-Boot 2021.10 (Dec 15 2023 - 06:47:44 +0000) 
 
CPU:   Renesas Electronics CPU rev 1.0 
Model: smarc-rzv2l 
DRAM:  1.9 GiB 
WDT:   watchdog@0000000012800800 
WDT:   Started with servicing (60s timeout) 
MMC:   sd@11c00000: 0, sd@11c10000: 1 
Loading Environment from MMC... OK 
In:    serial@1004b800 
Out:   serial@1004b800 
Err:   serial@1004b800 
U-boot WDT started! 
Net:   eth0: ethernet@11c20000 
Hit any key to stop autoboot: 2 
=> 
 
Then, you need to hit any key to stop autoboot within 3 sec. 

 
5. Load the binary files listed in 1. from microSD card to RAM by executing the commands below on the 

console. Here, N denotes the partition number in which you stored those binaries. 
 
dcache off 
mmc dev 1 
fatload mmc 1:N 0x0001FF80 rzv2l_cm33_rpmsg_demo_secure_vector.bin 
fatload mmc 1:N 0x42EFF440 rzv2l_cm33_rpmsg_demo_secure_code.bin 
fatload mmc 1:N 0x00010000 rzv2l_cm33_rpmsg_demo_non_secure_vector.bin 
fatload mmc 1:N 0x40010000 rzv2l_cm33_rpmsg_demo_non_secure_code.bin 
cm33 start_debug 0x1001FF80 0x00010000 
dcache on 
 

 
6. Now that CM33 program has been started to run. With respect to the behavior of sample program, please 

see 4.5. 
 
4.4 CA55 Sample Program Invocation 
You need to follow the procedure shown below to invoke CA55 sample program running on Linux. 

 
1. Boot up Linux by executing the following command on u-boot: 
 
run bootcmd 
 

2. Login as “root” 
 
smarc-rzv2l login: root 
 

3. Run CA55 sample program by executing the following command on Linux. 
 
root@smarc-rzv2l:~# rpmsg_sample_client 
 

4. Then, you can see the following message on the console relative to CN14 of SMARC carrier board. Be 
sure that you invoke CM33 program in advance. 
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Successfully probed IPI device 
metal: info:      metal_uio_dev_open: No IRQ for device 42f00000.rsctbl. 
Successfully open uio device: 42f00000.rsctbl. 
Successfully added memory device 42f00000.rsctbl. 
metal: info:      metal_uio_dev_open: No IRQ for device 43000000.vring-ctl0. 
Successfully open uio device: 43000000.vring-ctl0. 
Successfully added memory device 43000000.vring-ctl0. 
metal: info:      metal_uio_dev_open: No IRQ for device 43200000.vring-shm0. 
Successfully open uio device: 43200000.vring-shm0. 
Successfully added memory device 43200000.vring-shm0. 
metal: info:      metal_uio_dev_open: No IRQ for device 43100000.vring-ctl1. 
Successfully open uio device: 43100000.vring-ctl1. 
Successfully added memory device 43100000.vring-ctl1. 
metal: info:      metal_uio_dev_open: No IRQ for device 43500000.vring-shm1. 
Successfully open uio device: 43500000.vring-shm1. 
Successfully added memory device 43500000.vring-shm1. 
metal: info:      metal_uio_dev_open: No IRQ for device 42f01000.mhu-shm. 
Successfully open uio device: 42f01000.mhu-shm. 
Successfully added memory device 42f01000.mhu-shm. 
Initialize remoteproc successfully. 
Initialize remoteproc successfully. 
 
****************************************** 
*   rpmsg communication sample program   * 
****************************************** 
 
1. communicate with RZ/V2L CM33 ch0 
2. communicate with RZ/V2L CM33 ch1 
 
e. exit 
 
please input 
> 
 

5. Type 1 if RPMsg channel 0 is used on CM33 RPMsg sample program under default setting. Otherwise, 
type2 for staring the communication. 

 
 

4.5 Overview of Sample Program Behavior 
The behavior of sample program is as follows: 

1. Wait until a communication channel between CA55 and CM33 is established. 
2. Once the communication channel is established, CA55 sample program starts to send the message to 

CM33 with incrementing its size from the minimum value 17 to the maximum value 488. At that time, the 
message like the following should be shown in the console connected to CN14 of SMARC carrier board: 
 
Sending payload number 148 of size 165 
 

3. When CM33 receives the message sent from CA55, the echo reply is sent back to CA55. 
4. When CA55 receives the echo reply, the message below should be displayed in the console connected to 

CN14 of SMARC carrier board: 
 
echo test: sent : 165 
 received payload number 148 of size 165 
 

5. After the message which has 488 bytes sized payload is sent from CA55 to CM33 and CM33 sends back 
the echo reply, the message for terminating the communication channel is sent from CA55 to CM33. 
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Then, CA55 and CM33 sample programs output the following log messages to the corresponding 
consoles respectively when receiving the termination message. 

 
• Message shown on CA55 side: 
 
****************************************** 
*   rpmsg communication sample program   * 
****************************************** 
 
1. communicate with RZ/V2L CM33 ch0 
2. communicate with RZ/V2L CM33 ch1 
 
e. exit 
 
please input 
> 
 
If you would like to quit the application, please type e. 

 
• Termination message on CM33 side 
 
De-initializating remoteproc 
 

6. Then, CM33 side re-waits for the establishment of connection channel. You can see the following log on 
the console a short time later: 

 
creating remoteproc virtio 
initializing rpmsg vdev 
 

5. Sample Program Invocation on RZ/V2H EVK 
5.1 Hardware setup 
Connect J-Link to RZ/V2H EVK. For details, please refer to Getting Started with RZ/V Flexible Software 
Package. 

 

5.2 CM33/CR8 Sample Program Setup 
Here are the procedures for setting up the sample program running on CM33 and CR8: 
1. Extract r01an7254ej0200-rzv-multi-os-pkg.zip on your development PC. 
2. Extract either of rzv2h_cm33_rpmsg_demo.zip or rzv2h_cr8_ rpmsg_demo.zip included in 

r01an7254ej0200-rzv-multi-os-pkg.zip. 
3. Open e2 studio 2024-04 and click File > Import. 
4. Double-click General and select Existing Projects into Workspace as shown in Figure 5-1: 
 

 

Figure 5-1.   Import sample project (RZ/V2H) (1) 

https://www.renesas.com/document/apn/rzv-getting-started-flexible-software-package
https://www.renesas.com/document/apn/rzv-getting-started-flexible-software-package
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5. Input the path to the directory of the sample program you would like to import, press Enter key and click 
Finish button. 

 

 

Figure 5-2.   Import sample project (RZ/V2H) (2) 

 
6. (Optional) By default RPMsg channel 0 and 1 are configured to be used on CM33 and CR8 respectively. 

If you would like to change the channel, open the property of MainTask#0 on FSP Smart Configurator, 
you need to specify the number of channel you would like to use for Thread Context and to push 
Generate Project Content button. If Generate Project Content pop-up is shown, click Proceed to 
reflect the change to the source code. 

 

 

Figure 5-3.   RPMsg Channel Setting (RZ/V2H) 
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7. Build the project from Choose Project > Build Project. 
8. If the build is successfully completed, build artifacts as listed below should be generated in Debug and/or 

Release directory of the project you imported in accordance with the active Build Configuration. 
• rzv2h_<cpu>_rpmsg_demo.elf 
• rzv2h_<cpu>_rpmsg_demo.bin  

 
<cpu> stands for either cm33 or cr8. 

 
 

5.3 Note for CR8 Sample Program 
• CR8 Sample Program expects that CR8 and CM33 Sample Program Projects are imported to the same 

e2 studio workspace. Otherwise, FSP Smart Configurator won’t work for CR8 Sample Program. 
• Please note that the CR8 Sample program is created for CR8 Core0, not for CR8 Core1. 
  

5.4 CM33/CR8 Sample Program for the communication with Linux 
5.4.1 CM33/CR8 Sample Program Invocation using J-Link 
Carry out the procedures as shown below for setting up CM33 and/or CR8 sample program for 
communicating with Linux running on CA55: 

1. Click Debug button shown below: 
 

 

Figure 5-4.   Select of Debug Configuration (RZ/V2H) 

 
2. For the first time, you may need to choose rzv2h_<cpu>_rpmsg_demo Debug_Flat or 

rzv2h_<cpu>_rpmsg_demo Release_Flat in accordance with the build configuration you are using. At that 
time, choose the appropriate debug configuration and click OK. 

 

 

Figure 5-5.   Debug Function Launch 
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If Confirmation Perspective Switch window below appears, please press Switch to go ahead. 

 

 

Figure 5-6.   Confirmation window to open the Debug Perspective 

 
3. When the debug perspective is opened, Program Counter (PC) should be located at the top of 

Warm_Reset_S and Reset Handler for CM33 and CR8 e2 studio project respectively. Then, you need to 
press the button in as shown in Figure 5-7. 

 

 

Figure 5-7.   How to start to debug Sample Program (1) 
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4. The program should stop at the top of main function. Then, click the same button to continue. 
 

 

Figure 5.8.   How to start to debug Sample Program (2) 

 
5. CM33 and/or CR8 sample program start and waiting for the establishment of RPMsg channel with CA55. 
 
5.4.2 CM33/CR8 Sample Program Invocation from u-boot 
On RZ/V2H EVK, you can invoke RPMsg Sample Program from u-boot. Here is the example of procedure: 

1. Place rzv2h_<cpu>_rpmsg_demo.bin in SD card where Linux kernel and Device Tree Blob are stored. 
2. Insert SD card into SD1 of RZ/V2H EVK. 
3. Turn on RZ/V2H EVK. Then, you should see the following message in the console connected to CN12 of 

RZ/V2H EVK. 
 
U-boot  
 

4. Hit any key within 3 sec. to stop autoboot. 
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5. Carry out the following setup on u-boot to kick CM33 and/or CR8. 
 
• For CM33 
 
=> setenv cm33start 'dcache off; mw.l 0x10420D2C 0x02000000; mw.l 0x1043080c 
0x08003000; mw.l 0x10430810 0x18003000; mw.l 0x10420604 0x00040004; mw.l 
0x10420C1C 0x00003100; mw.l 0x10420C0C 0x00000001; mw.l 0x10420904 0x00380008; 
mw.l 0x10420904 0x00380038; ext4load mmc 0:2 0x08001e00 
boot/rzv2h_cm33_rpmsg_demo.bin; mw.l 0x10420C0C 0x00000000; dcache on' 
=> run cm33start 
 

• For CR8 
 
=> setenv cr8start 'dcache off; mw.l 0x10420D24 0x04000000; mw.l 0x10420600 
0xE000E000; mw.l 0x10420604 0x00030003; mw.l 0x10420908 0x1FFF0000; mw.l 
0x10420C44 0x003F0000; mw.l 0x10420C14 0x00000000; mw.l 0x10420908 0x10001000; 
mw.l 0x10420C48 0x00000020; mw.l 0x10420908 0x1FFF1FFF; mw.l 0x10420C48 
0x00000000; ext4load mmc 0:2 0x12040000 boot/rzv2h_cr8_rpmsg_demo_itcm.bin; 
ext4load mmc 0:2 0x08180000 boot/rzv2h_cr8_rpmsg_demo_sram.bin; ext4load mmc 
0:2 0x40800000 boot/rzv2h_cr8_rpmsg_demo_sdram.bin; mw.l 0x10420C14 
0x00000003; dcache on;' 
=> run cr8start 
 

5.5 CA55 Sample Program Invocation 
1. Boot up Linux by executing the command stated below on u-boot for example: 
 
=> run bootcmd 
 

2. Login as “root” once Linux is booted up: 
 
rzv2h-evk-ver1 login: root 
 

3. Run RPMsg Sample Program by the command below: 
 
root@rzv2h-evk-ver1:~# rpmsg_sample_client 
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4. When Sample Program started to work successfully, you can see the following log on your console: 
 
[XXX] proc_id:0 rsc_id:0 mbx_id:0 
metal: info:      metal_uio_dev_open: No IRQ for device 10480000.mbox-uio. 
[XXX] Successfully probed IPI device 
metal: info:      metal_uio_dev_open: No IRQ for device 42f00000.rsctbl. 
[XXX] Successfully open uio device: 42f00000.rsctbl. 
[XXX] Successfully added memory device 42f00000.rsctbl. 
metal: info:      metal_uio_dev_open: No IRQ for device 43000000.vring-ctl0. 
[XXX] Successfully open uio device: 43000000.vring-ctl0. 
[XXX] Successfully added memory device 43000000.vring-ctl0. 
metal: info:      metal_uio_dev_open: No IRQ for device 43200000.vring-shm0. 
[XXX] Successfully open uio device: 43200000.vring-shm0. 
[XXX] Successfully added memory device 43200000.vring-shm0. 
metal: info:      metal_uio_dev_open: No IRQ for device 43100000.vring-ctl1. 
[XXX] Successfully open uio device: 43100000.vring-ctl1. 
[XXX] Successfully added memory device 43100000.vring-ctl1. 
metal: info:      metal_uio_dev_open: No IRQ for device 43500000.vring-shm1. 
[XXX] Successfully open uio device: 43500000.vring-shm1. 
[XXX] Successfully added memory device 43500000.vring-shm1. 
metal: info:      metal_uio_dev_open: No IRQ for device 42f01000.mhu-shm. 
[XXX] Successfully open uio device: 42f01000.mhu-shm. 
[XXX] Successfully added memory device 42f01000.mhu-shm. 
[XXX] Initialize remoteproc successfully. 
[XXX] proc_id:1 rsc_id:1 mbx_id:0 
[XXX] Initialize remoteproc successfully. 
[XXX] proc_id:0 rsc_id:0 mbx_id:1 
[XXX] Initialize remoteproc successfully. 
[XXX] proc_id:1 rsc_id:1 mbx_id:1 
[XXX] Initialize remoteproc successfully. 
 
****************************************** 
*   rpmsg communication sample program   * 
****************************************** 
 
1. communicate with CM33 ch0 
2. communicate with CM33 ch1 
3. communicate with CR8 ch0 
4. communicate with CR8 ch1 
5. communicate with CM33 ch0 and CR8 ch1 
 
e. exit 
 
please input 
> 
 

5. By inputting the number which performs the communication you would like to try on your console, Sample 
Program starts to work. 
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6. By typing e, Sample Program should be terminated with the message shown below: 
 
please input 
> e 
[XXX] 42f00000.rsctbl closed 
[XXX] 43000000.vring-ctl0 closed 
[XXX] 43200000.vring-shm0 closed 
[XXX] 43100000.vring-ctl1 closed 
[XXX] 43500000.vring-shm1 closed 
[XXX] 42f01000.mhu-shm closed 

 
5.6 Overview of Sample Program Behavior 
1. Wait until the valid communication channel among CA55, CM33 and/or CR8 is established. 
2. Once the channel is established, CA55 RPMsg Sample Program starts to send the message to CM33 

and/or CR8 with incrementing the message size from the minimum value 17 to the maximum value 488. 
During the communication, the message as shown below should be displayed on your console: 

 
[XXX] Sending payload number 148 of size 165 
 

3. When CM33 and/or CR8 receives the message sent from CA55, the echo reply is sent back to CA55. 
4. When CA55 receives the echo reply, the message below should be displayed on your console: 
 
[XXX] received payload number 148 of size 165 
 

5. After the message which has 488 bytes sized payload is sent from CA55 to CM33/CR8 and CM33/CR8 
sends back the echo reply, the message for terminating the communication channel is sent from CA55 to 
CM33/CR8. Then, Sample Program outputs the following log messages to your console: 

 
[XXX] ************************************ 
[XXX] Test Results: Error count = 0 
[XXX] ************************************ 
[XXX] Quitting application .. Echo test end 
[XXX] Stopping application... 
 

5.7 Note for Sample Program 
When trying 5. communication with CM33 ch0 and CR8 ch1, be sure to invoke CM33 RPMsg Sample 
Program first followed by CR8 Sample Program beforehand. If Sample Program works as expected, the 
communications between CA55 and CM33 and between CA55 and CR8 work concurrently as shown in the 
following log: 
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[XXX] thread start 
[CR8 ] creating remoteproc virtio 
[XXX] thread start 
[CR8 ] initializing rpmsg shared buffer pool 
[CR8 ] initializing rpmsg vdev 
[CR8 ]  1 - Send data to remote core, retrieve the echo and validate its 
integrity .. 
[CM33] creating remoteproc virtio 
[CR8 ] Remote proc init. 
[XXX] cond signal 1 sync:0 
[CM33] initializing rpmsg shared buffer pool 
[CM33] initializing rpmsg vdev 
[CM33]  1 - Send data to remote core, retrieve the echo and validate its 
integrity .. 
[CM33] Remote proc init. 
[CR8 ] RPMSG endpoint has created. rp_ept:0xffffa4c67870 
[CR8 ] register sig:2 succeeded. 
[CR8 ] register sig:15 succeeded. 
[CM33] RPMSG endpoint has created. rp_ept:0xffffa5468870 
[CR8 ] RPMSG service has created. 
[CR8 ] sending payload number 0 of size 17 
[XXX] cond signal 0 sync:0 
[CM33] RPMSG service has created. 
[CM33] sending payload number 0 of size 17 
[XXX] cond signal 1 sync:0 
[CR8 ]  received payload number 0 of size 17 
[XXX] cond signal 0 sync:0 
[CM33]  received payload number 0 of size 17 
 
(snip) 
 
[CR8 ]  received payload number 469 of size 486 
[CR8 ] sending payload number 470 of size 487 
[331] cond signal 1 sync:0 
[CR8 ]  received payload number 470 of size 487 
[CR8 ] sending payload number 471 of size 488 
[XXX] cond signal 1 sync:0 
[CR8 ]  received payload number 471 of size 488 
[CR8 ] ************************************ 
[CR8 ]  Test Results: Error count = 0 
[CR8 ] ************************************ 
[XXX] cond signal 1 sync:0 
[CM33] Quitting application .. Echo test end 
[CM33] Stopping application... 
[CR8 ] Quitting application .. Echo test end 
[CR8 ] Stopping application... 
 

 

6. Reference Documents 
• R01AN6240: RZ/V2L Getting Started with Flexible Software Package 
• R01US0565: RZ/V Verified Linux Package Version 3.0.5 Release Note 
• R01US0617: SMARC EVK of RZ/V2L Linux Start-up Guide 
• R12UZ0147: RZ/V2H Evaluation Board Kit (Secure type) Hardware Manual 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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